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Installing and Licensing Softimage

Autodesk® Softimage® is installed and run with Autodesk stand-alone 
or network licensing. Autodesk® Softimage® Advanced is installed 
and run with Autodesk network licensing only.

If you want to run Softimage or Softimage Advanced on a Linux 32-
bit or 64-bit operating system, you must use the SPM licensing 
scheme. See Installing and Licensing Softimage on Linux for more 
information.

This document provides quick starts for the following workflows:

• Installing, registering, and activating Softimage using an Autodesk 
stand-alone license. A single serial number activates Softimage on 
a single Windows workstation.

See Quick Steps: Installing Softimage and Activating a Stand-Alone 
License on page 5.

• Installing, registering, and activating Softimage using an Autodesk 
multi-seat stand-alone license. A single serial number activates 
Softimage on several Windows workstations.

See Quick Steps: Installing Softimage and Activating a Multi-Seat 
Stand-Alone License on page 10.

• Installing and configuring an Autodesk network license server 
from which a network-licensed version of Autodesk Softimage or 
Autodesk Softimage Advanced can obtain licenses.

See Quick Steps: Installing the Autodesk Network License Server on 
page 11.

• Installing and running a network licensed version of Softimage on 
a Windows workstation. This process installs Softimage and then 
prompts you to enter the name of the Autodesk network license 
server(s) from where you will obtain your activated license to run 
Softimage.

See Quick Steps: Installing A Network-Licensed Version of Softimage 
on page 15.



5 • Autodesk Softimage   

Installing and Licensing Softimage

• Installing and configuring the mental ray standalone rendering 
software. This process installs mental ray and then prompts you to 
enter the name of the SPM license server(s) from where you will 
obtain your activated license to run the rendering software.

See Quick Steps: Installing the mental ray Standalone on page 19.

• Client Install for Windows. See Quick Steps: Running Softimage 
Remotely (Client Install) on page 23.

• Site Deployment. See Quick Steps: Site Deployment on page 25.

• Uninstalling Softimage and its components. See Quick Steps: 
Uninstalling Softimage on page 38.

Quick Steps: Installing Softimage and 
Activating a Stand-Alone License

These are the basics steps for installing, registering, and activating 
Autodesk Softimage using a stand-alone license. Your single serial 
number activates Softimage on a single Windows workstation. When 
you activate your license, the license is node-locked to your computer. 

For more information about the various features of your stand-alone 
license, such as the ability to transfer your license from the office 
desktop to the office laptop, see the Autodesk Stand-Alone Licensing 
Guide.

To install and activate Autodesk Softimage

1. Run the Softimage Setup program. 
For more information, see Running the Softimage Setup Program 
on page 30.

2. Accept the End User License Agreement (EULA).

3. Specify the installation path. 
For more information, see Specifying the Destination Folder on 
page 32.

4. Select Softimage Software as the package to install.
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5. Select Typical for the setup type. 

For more information, see Choosing a Setup Type on page 33.

A Typical installation of Softimage includes the mental ray standalone 
software components; however, the mental ray and distributed 
rendering services are not configured unless you choose the Custom 
Install option. See To install Softimage and the mental ray standalone 
on page 21.
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6. Select Stand-Alone License.

7. Review your setup choices, and when you’re ready to go ahead 
with the installation, click Next.

8. Leave the Start Softimage check box selected and click Finish.
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9. Wait for the Product Activation wizard to launch.

10. In the Activation dialog box, select Activate and click Next.

11. On the Register Today page, enter a valid serial number and 
product key. Click Next.

If you select Run the product, you will launch Softimage in trial 
mode. You can use Autodesk Softimage in trial mode for 30 days 
from the first time you launch it. You can register your license at 
any time before or after the trial period expires.
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12. Select Get an Activation Code and click Next.

Get an Activation Code allows you to register online (this requires 
Internet access), your activation code is automatically retrieved 
from Autodesk and you can start Softimage.

Enter an Activation Code allows you to register offline, and you 
must request an activation code from Autodesk. Upon its receipt, 
you manually enter the activation code in the Product Activation 
wizard. The Product Activation wizard is displayed every time you 
launch a product that has not been registered. This procedure is 
described in detail in the Autodesk Stand-Alone Licensing Guide.

13. If you have a user ID and password, you can log in. If not, click the 
Create a User ID Now link. Click Next.

14. Fill in your information and password on the Create User ID page 
and click Next.

15. Complete the Account Information page and click Next.

16. On the Choose Account page, make sure that your user account is 
selected and click Next.

17. You are notified of registration and activation status on the 
Registration - Activation Confirmation page. Click Finish.

18. Enjoy Autodesk Softimage!



Quick Steps: Installing Softimage and Activating a Multi-Seat Stand-Alone License

    Installation Guide • 10

Quick Steps: Installing Softimage and 
Activating a Multi-Seat Stand-Alone License

These are the basic steps for installing, registering, and activating the 
Softimage product using an Autodesk multi-seat stand-alone license. 
A single serial number allows you to activate Softimage on several 
Windows workstations. 

1. During the first installation of Softimage with a multi-seat stand-
alone license, you must follow all the installation steps including 
the full registration and activation process as you would for a 
single stand-alone license. See Quick Steps: Installing Softimage 
and Activating a Stand-Alone License on page 5.

2. After that, all subsequent installations of Softimage on other 
workstations are automatically activated as long as the current 
computer has an active Internet connection and the serial number 
is verified as being associated to a valid multi-seat license.

You can use a site deployment file to simplify the installation process. 
This creates a server image that any client computer can access to 
install Softimage. See Quick Steps: Site Deployment on page 25.
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Quick Steps: Installing the Autodesk Network 
License Server

These are the basic steps for installing and configuring an Autodesk 
network license server. Once your server is set up, you can install and 
run network-licensed versions of Autodesk Softimage or Autodesk 
Softimage Advanced on Windows workstations.

Follow these steps to get your license server up and running quickly. 
However, for complete descriptions of all procedures and features of 
network licensing, please refer to the Autodesk Network Licensing 
Guide.

To access the Autodesk network license server setup files:

• Run the programs directly from their folder location on the 
Software DVD.

Or

• Download the Web setup package and extract the contents onto 
your hard disk.

Install the Autodesk Network License Manager

1. Run NLM_x86.msi or NLM_x64.msi on the computer that will be 
your license server. The NLM setup installs the Autodesk network 
license manager (LMTools Utility) which allows you to configure 
and manage your license server(s).

2. Specify the installation folder and select whether you want 
Everyone or Just me (the computer Administrator) to have access 
privileges. Click Next and Next again at the following screen.

Install the Autodesk NLA for Softimage 7.5

3. Run setup_NLASI.exe on the computer where you installed the 
license server. The NLASI installs the Network License Activation 
utility for Softimage 7.5 and it activates your Softimage licenses on 
the network license server. 
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You can install the NLASI anywhere on the network and activate 
licenses on a remote license server, but you must obtain the 
computer’s host ID manually. You can use this option at the 
command prompt: lmutil lmhostid -hostname

Activate with the NLA for Softimage 7.5

4. Choose Start > Programs > Autodesk > Network License 
Activation > Softimage 7.5 or Softimage Advanced 7.5.

5. Choose Direct connect (over the Internet).

6. Enter your server information:

- Enter your Serial number.

- Choose your License server model.

- Enter the computer name of your server.

- Click Lookup to automatically get the host ID. This only works 
if you are running NLASI on the same computer as your license 
server.

7. Review your choices and click Next.

8. Log in to your Autodesk account with a valid User ID and 
Password. If you do not have an Autodesk user account, you must 
create one. Click Create User ID Now.

9. When the License(s) Received window is displayed, your license 
file is ready to be saved:

- Enter the location where you want to save your license file in the 
Save License File for [computer name] field. The recommended 
path is C:\Program Files\Autodesk Network License 
Manager\License.

If you are having problems registering with the NLASI software, you 
can use the online registration tool at 
https://registeronce.autodesk.com.

Japanese customers should not click the link: Users from Japan with 
an existing Contract ID, please click here. Autodesk no longer uses 
this registration method for Japan.

https://registeronce.autodesk.com
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- Select Insert the new license information into it. Click Next.

- When the License Activation Successful! page is displayed, click 
Done.

Configure Your License Server

10. Choose Start > Programs > Autodesk > Network License Manager 
> LMTOOLS Utility.

11. Click the Service/License File tab and select Configure Using 
Services.

12. Click the Config Services tab:

- For Service Name, select the service you want to use to manage 
licenses. If FLEXnet® is managing other software on your 
computer in addition to Autodesk, you can change the service 
name to avoid confusion. For example, you can rename Flexlm 
Service 1 to Autodesk Server 1.

- For Path to the lmgrd.exe file, enter the path to the Network 
License Manager daemon (lmgrd.exe). The default path is 
C:\Program Files\Autodesk Network License Manager.
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- For Path to the license file, enter the path to your license file.

- For Path to the debug log file, enter a path to create a debug log. 
Save it to C:\Program Files\Autodesk Network License Manager 
and be sure to include the .log file extension in the name.

- Select Use Services.

- Select Start Server at Power Up.

- Click Save Service to save the new configuration.

13. Click the Start/Stop/Reread tab:

- Click Start Server to start the license server.

- Click ReRead License File to refresh the Network License 
Manager with any changes made to the license file.

The license server is ready to respond to client requests: You can close 
LMTools.

For instructions on how to install a network-licensed version of 
Autodesk Softimage or Autodesk Softimage Advanced, see Quick 
Steps: Installing A Network-Licensed Version of Softimage on page 15.
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Quick Steps: Installing A Network-Licensed 
Version of Softimage

These are the basic steps for installing and running a network-licensed 
version of Autodesk Softimage or Autodesk Softimage Advanced on a 
Windows workstation. The Setup program installs the Softimage 
software files and then prompts you to enter the name of the 
Autodesk license server(s) from where you will obtain your activated 
license. It is assumed that your license server has already been set up 
as described in Quick Steps: Installing the Autodesk Network License 
Server on page 11.

1. Run the Softimage Setup program. 
For more information, see Running the Softimage Setup Program 
on page 30.

2. Accept the End User License Agreement (EULA).

3. Specify the installation path. 
For more information, see Specifying the Destination Folder on 
page 32.

4. Select Softimage Software or Softimage Advanced Software as the 
package to install.
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5. Select Typical for the setup type. 

For more information, see Choosing a Setup Type on page 33.

6. In the Autodesk License Server Location box, enter the computer 
name or IP address of the computer that is configured as the 
license server. 

A Typical installation of Softimage includes the mental ray standalone 
software components; however, the mental ray and distributed 
rendering services are not configured unless you choose the Custom 
Install option. See To install Softimage and the mental ray standalone 
on page 21.
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7. Click Add to include the license server name in the file 
c:\Softimage\Softimage_7.5\adlm\licenses\Autodesk.lic. This file 
lets Softimage know from which server to obtain a license. You 
can always edit this file later to change or add a server name.

To add more than one server to the list, enter another computer 
name and click Add again. Click the Next button to cycle through 
the server names you have set.

8. Click Next (at the bottom of the dialog box) to continue.

9. Review your setup choices, and when you’re ready to go ahead 
with the installation, click Next.

10. Leave the Start Softimage check box selected and click Finish.
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11. Enjoy Autodesk Softimage!
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Quick Steps: Installing the mental ray 
Standalone

You can choose to install only the mental ray standalone software on 
the computer you want to use for rendering (see To install mental ray 
standalone only), or you can choose to install both Softimage and the 
mental ray standalone software on the same computer (see To install 
Softimage and the mental ray standalone).

You make this choice at different places during the installation 
process, but either way, the mental ray standalone software must 
obtain its license from an SPM license server. It is assumed that the 
SPM license server is already set up and running with the appropriate 
activated licenses as described in the SPM License Server Guide.

To install mental ray standalone only

1. Run the Softimage Setup program. 
For more information, see Running the Softimage Setup Program 
on page 30.

2. Accept the End User License Agreement (EULA).

3. Specify the installation path. 
For more information, see Specifying the Destination Folder on 
page 32.

4. Select Mental ray components and software as the package to 
install.
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5. Review your setup choices, and when you’re ready to go ahead 
with the installation, click Next.

6. In the mental ray SPM License Server Location box, enter the 
computer name or IP address of the computer that is configured 
as the license server. See Selecting the SPM License Server on 
page 34.

7. Click Add to include the license server name. When you are done, 
click Next.

8. Configure one or both types of distributed rendering (satellite and 
standalone) by selecting its checkbox. You can then configure a 
port for each type of distributed rendering you selected. See 
Configuring Distributed Rendering on page 36.

9. When you click OK, Setup will install and start the services used 
for distributed rendering.

In Softimage, choose Help > User’s Guide > Rendering > Distributed 
Rendering for complete details on how to set up a distributed 
rendering environment.
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To install Softimage and the mental ray standalone

1. Run the Softimage Setup program. 
For more information, see Running the Softimage Setup Program 
on page 30.

2. Accept the End User License Agreement (EULA).

3. Specify the installation path. 
For more information, see Specifying the Destination Folder on 
page 32.

4. Select Softimage Software or Softimage Advanced Software as the 
package to install.

5. Select Custom Install for the setup type.

6. Make sure both Softimage software and documentation and 
Configure mental ray and distributed rendering services software 
options are selected. Click Next.
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7. The subsequent Setup screens are dependent on whether you are 
installing the Softimage or Softimage Advanced software package. 
Refer to the Quick Steps procedures for either package.

8. Review your setup choices, and when you’re ready to go ahead 
with the installation, click Next.

The Configure mental ray and distributed rendering services option 
adds the following steps to the end of the installation procedure:

9. In the mental ray SPM License Server Location box, enter the 
computer name or IP address of the computer that is configured 
as the license server. See Selecting the SPM License Server on 
page 34.

10. Click Add to include the license server name and then click Next.

11. Configure one or both types of distributed rendering (satellite and 
standalone) by selecting its checkbox. You can then configure a 
port for each type of distributed rendering you selected. See 
Configuring Distributed Rendering on page 36.

12. When you click OK, Setup will install and start the services used 
for mental ray and distributed rendering.
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In Softimage, choose Help > User’s Guide > Rendering > Distributed 
Rendering for complete details on how to set up a distributed 
rendering environment.

Quick Steps: Running Softimage Remotely 
(Client Install)

You can install Softimage to a shared drive on the network and then 
run the Client Install to set up a “thin” version of Softimage on local 
computers. A thin version is one that doesn’t require a full installation 
of all the software files. 

Each local machine must have access privileges to the shared location 
where Softimage is installed on the network. 

To set up a shared installation

1. Install Softimage to a shared drive or network location.

On the computer from which you want to run Softimage, do the 
following: 

2. Run the Client Install program. You can get it from the downloads 
site at http://www.autodesk.com/softimage-downloads or from its 
folder location on the software DVD.

3. Click Yes to accept the End User License Agreement (EULA).

4. Specify the location where Softimage was installed. 

Enter a Universal Naming Convention (UNC) path to a shared 
folder on the local computer or on the network, such as 
\\buzz\infinity\. Click Next.

5. Specify a destination folder for the Softimage client. Click Next to 
copy a small number of batch files and update the registry of the 
client.

http://www.autodesk.com/softimage-downloads
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To complete the Client installation, do the following to allow access to 
the Compiled Help documentation from its remote location:

6. Add the path to the documentation as a trusted site in the Internet 
Explorer’s security options:

- Start Internet Explorer, go to the Tools > Internet Options 
menu, and click the Security tab. Select the Trusted sites zone 
and click the Sites button.

- Add this path to the documentation to the list of trusted sites:

\\<XSI_Remote_Install_Path>\softimage_7.5\Doc\

Then click the Add button.

To specify a UNC path, turn off the option that requires “server 
verification (https:) for all sites in this zone”.

7. Restart your computer for the registry modifications to take effect.

You can now access the documentation remotely without getting 
any blank pages or error messages.
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Quick Steps: Site Deployment

If you need to install Softimage and the mental ray standalone on 
many computers, you can simplify the process by using a site 
deployment configuration file to automate the setup.

All you need to do is put a copy of the Setup program files on a server 
and then run the Setup program from the workstations on which you 
want to install the software.

Clients can launch a silent install (even remotely through a telnet 
window) using a SiteDeploy.ini file that contains all the setup options 
for your site.

Copying Setup Files to a Network Location

1. Copy the Softimage Setup files to a network location.

- Download the Softimage Setup and extract the contents of the 
compressed file to a shared location on your network.

or

- Copy the Softimage Setup files from their location on the 
Software DVD to a shared location on your network.

2. After the files are copied, you should have a folder containing the 
following files:

Do not confuse clients performing a server-based installation with 
the client machines that are created during a Client Install for 
Windows. The Client Install allows you to run Softimage from a 
remote location using a few locally installed files, whereas the clients 
in a site deployment are installing a full version of Softimage locally, 
but using a Setup program hosted on a remote computer.

For more information about the Client Install, see Quick Steps: 
Running Softimage Remotely (Client Install) on page 23.

_Setup.dll data1.cab

data1.hdr data2.cab

dotnetfx.exe ISSetup.dll
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Creating and Deploying a Profile

The SiteDeploy.ini file is a configuration file that contains the setup 
profile for your site. This is the file that client machines run to install 
the software (and set all the appropriate options).

You can create multiple profiles for specific situations (for example, a 
computer where Softimage will be installed on a different drive). A 
documented version of the site deployment configuration file is 
described in The Default SiteDeploy.ini File on page 27.

3. Make a backup copy of the original SiteDeploy.ini file.

4. Edit SiteDeploy.ini to specify the installation options for your site 
(for example, you’ll want to specify the licensing method you are 
using to install your product).

5. Run sisetup.exe –profile:<path>\SiteDeploy.ini. 

For example:

\\toto\setup_softimage_7.5\sisetup.exe -
profile:\\toto\setup_softimage_7.5\SiteDeploy.ini -noreboot

layout.bin setup_NLASI.exe

NLM_x86.msi NLM_x64.msi

setup.bmp setup.exe

setup.ini setup.inx

Setup.iss setupcfg.ini

sisetup.exe SiteDeploy.ini

vcredist_x64.exe vcredist_x64.vc9.exe

vcredist_x86.exe vcredist_x86.vc9.exe

The path to the SiteDeploy.ini file must not contain spaces.
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sisetup.exe Usage and Options

sisetup.exe [-installpath:path_name][-noreboot]
sisetup.exe [-profile:filepath_name][-installpath:path_name]
[ -noreboot ]
sisetup.exe [-uninstall][-noreboot]

The Default SiteDeploy.ini File

Please take note that the commented option entries in the site 
deployment file described below are optional.

[Setup]

; Install Softimage software: TRUE or FALSE. To deploy the 
mental ray standalone only, set InstallSoftware=FALSE.

InstallSoftware=TRUE

; Destination folder

InstallPath=c:\Softimage

; User Directory. Uncomment if you wish to use a specific 
value.

; Before Vista: %SystemDrive%\users\%USERNAME%. Vista and up: 
%USERPROFILE%

; UserRoot=%USERPROFILE%

Option Description

-noreboot Prevents the Setup from rebooting the 
computer at the end of the installation.

-profile:filepath_name Specifies the profile file to use for silent 
installation.

-installpath:path_name Specifies where to install the application 
(overwrite profile).

-uninstall Forces the Setup to uninstall the application: 
no questions are displayed.

-help Displays this help.
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[ADLM]

; Product Key: 590A1 for Softimage, 591A1 for Softimage 
Advanced

ProdKey=590A1

; Autodesk serial number for activating the product. Default 
000-00000000 (Trial)

SerialNumber=000-00000000

; Licensing method: Standalone, Multi Seat Standalone or 
Network

LicMethod=Standalone

[MentalRay]

; Configure Satellite distributed rendering.

SatInstallService=TRUE

; Satellite port to use.

SatPort=7005

; Configure Standalone distributed rendering.

SdrInstallService=FALSE

; Standalone port to use.

SdrPort=7006

If you are deploying the installation of Softimage on computers 
running the Microsoft Vista operating system, uncomment the 
UserRoot option so that the users folder is created properly with the 
%USERPROFILE% environment variable. If this line remains 
commented out, the users folder is created by default in 
c:\users\%USERNAME% which is compatible with Windows 
operating systems prior to Vista.

The first site deployment of Softimage using LicMethod=Multi 
Seat Standalone will require that the client follow all the 
registration and activation steps. After that, subsequent deployments 
on other workstations are automatically activated as long as the 
current computer has an active Internet connection and the serial 
number is verified as being associated to a valid multi-seat license.
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; Configure SPM for Standalone rendering and Standalone 
distributed rendering. If SdrInstallService is TRUE

; then SPMConfigure is ignored and internally set to TRUE

SPMConfigure=TRUE

; SPM port to use.

SPMPort=7050

; List SPM servers separated by ';'. Example: server1;server2

SPMServers=spmhost0

[Miscellaneous]

; Check for IE if set to YES

CheckForInternetExplorer=FALSE

If Softimage is running on the same computer as the SPM server (in 
the case of a local SPM installation), you can simply enter 
localhost for SPMServers. localhost is the alias name for the 
“local” or “loopback” IP address (127.0.0.1) for the current computer 
on which a program is running.

Internet Explorer is required by the Net View feature of Softimage. If 
it is not present on a particular computer, the setup program will fail 
to register certain files when you later install Softimage on another 
computer from the network location. 

• Enter YES if you want the setup program to test for Internet 
Explorer on the local computer when installing from the network 
location. 

• Enter FALSE if you are certain that the required version of 
Internet Explorer (IE 5 and later) is already installed on all 
computers on which you will be installing Softimage.
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Running the Softimage Setup Program

1. You can run the Softimage setup program directly from the 
Software DVD or you can download it from 
http://www.autodesk.com/softimage-downloads and extract it to 
your computer.

• From the Software DVD, the autorun program opens the master 
setup program. 

If autoplay is turned off on your system, double-click autorun.exe 
at the root of the DVD to launch the master setup program.

• Download the Softimage setup program from 
http://www.autodesk.com/softimage-downloads and extract the 
Setup program onto your hard disk.

http://www.autodesk.com/softimage-downloads
http://www.autodesk.com/softimage-downloads
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2. Accept the End User License Agreement (EULA). You must accept 
the terms of the license agreement to continue.
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Specifying the Destination Folder

You can choose the folder in which you want to install Softimage.

By default, Softimage is installed in the folder C:\Softimage. We 
recommend you use this folder but if you want to use a different 
location, click Browse. 

Avoid using spaces as part of the install path name. Also, if you are 
installing on a Japanese operating system, do not use Japanese or any 
double-byte characters. These may cause the installation to fail. You 
will be prompted to choose a different installation path.

When the Destination Folder is the one you want, click Next to 
continue.

After installation, the %SI_HOME% environment variable points to 
the directory in which Softimage is installed.
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Choosing a Setup Type

• Select Typical Install or Next (Typical Install is the default). The 
Setup program installs the following components:

- The Autodesk Softimage software. 

A typical installation of Softimage also includes the mental ray 
standalone software components; however, the mental ray and 
distributed rendering services are not configured unless you 
choose the Custom Install option.

- The Autodesk Softimage SDK components. 

- The User’s Guide and the SDK Guide, which are installed to 
your system as several files in the Compiled HTML Help format 
(*.chm). These guides provide complete procedural information 
for using the software and are available from the Help menu 
within Softimage.

- The XSI_Samples project that you can use to get started with 
Softimage.

• Select Custom Install if you want to install Softimage and 
configure the mental ray standalone and distributed rendering 
(satellite and standalone) services. See Quick Steps: Installing the 
mental ray Standalone on page 19.

S
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Selecting the SPM License Server

This dialog box opens if you selected the Configure mental ray and 
distributed rendering services option for a Custom Install, or if you 
are installing only the mental ray components and software option as 
the software package.

1. Enter the name of the SPM license server. 

In the License Server box, enter the computer name or IP address 
of the computer that is running the SPM server. For example, if 
you type buzz, Setup tries to connect to the license server called 
buzz on port 7050.

2. Click Add to append this server name to the SPM_HOST variable 
in the set_spmhost.bat file. You can always edit this environment 
variable later to change or add a server name.

To add more than one server to the list, enter another computer 
name and click Add again. Click the Next button to cycle through 
the server names you have set.
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Choosing a TCP/IP Port for the SPM Service

The SPM server communicates with SPM clients connected on the 
same network through a TCP/IP port. The SPM license server listens 
on this port defined by mi-spm (port 7050 by default). When a client 
needs a license, it contacts the license server on that port to get it.

3. In the Port Settings box, select a port for SPM to use when 
communicating with the SPM license server.

By default, SPM’s TCP/IP service is defined at port 7050. If you 
need to specify a different port, select the Edit Port Number check 
box and either enter a new port number or click Next Free Port to 
find the next available port.

4. Click Next when you’re finished.
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Configuring Distributed Rendering

This dialog box opens if you selected the Configure mental ray and 
distributed rendering services option for a Custom Install, or if you 
are installing mental ray components and software option as the 
software package.

Choosing a Distributed Rendering Type

You can configure two types of distributed rendering:

• Satellite distributed rendering requires a Softimage license that 
supports Satellite rendering for the master machine. No 
additional licences are required for the slave machines. Select the 
Configure satellite distributed rendering check box for this 
option.
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• Standalone distributed rendering requires a Softimage license that 
supports standalone rendering for the master machine. Each slave 
processor requires an additional mental ray standalone license. 
Select the Configure standalone distributed rendering check box 
for this option.

To configure one or both types of distributed rendering, activate it by 
selecting its checkbox. This activates its port selection options. You 
can then choose a port for its mental ray service to listen on.

Choosing a TCP/IP Port for Distributed Rendering

You must select a port for mental ray to use when communicating 
with other computers during distributed rendering sessions.

Choosing a Port

• By default, the Setup program automatically chooses port 7004 or 
the next available port for whichever type of distributed rendering 
you’ve configured. If you need to specify a different port, select 
Edit Port Number and either enter a new port number or click 
Next Free Port to find the next available port.

When you click Next, the setup program will install and start the 
services used for distributed rendering.

5. Select Finish.

In Softimage, choose Help > User’s Guide > Rendering > Distributed 
Rendering for complete details on how to set up a distributed 
rendering environment.

All computers in a distributed rendering network must run the 
same version of the mental ray software. It is strongly recommended 
that they also use the same TCP/IP port number for each distributed 
rendering type. It is particularly important to use the same TCP/IP 
port number if you are doing distributed rendering across different 
platforms. Any port number greater than 7024 is recommended.
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Quick Steps: Uninstalling Softimage

After you’ve installed the Softimage software, you can run the Setup 
program to add or remove any or all of the Softimage components. 
Any time you start the Setup program after Softimage is installed, it 
automatically opens in maintenance mode.

Make sure to back up any personal or Softimage user-configurable 
files before you remove all of the software.

To uninstall Softimage

1. Open the Softimage Setup Maintenance program:

• Run setup.exe from the Softimage install path. The default 
location is C:\Softimage\Softimage_7.5\Setup.

Or

• Run the Windows Add or Remove Programs utility.

A stand-alone license stays on your workstation when you uninstall 
Softimage. If you reinstall Softimage on the same workstation, the 
license information is still valid. You do not have to reactivate the 
product.
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2. Select one of the following options and click Next:

- Modify opens the Custom install dialog box where you can 
select the product components that you want to either add or 
remove.

- Repair is not a supported feature.

- Remove removes all previously installed components.
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